
Create tables in a database 

When you create a database, you store your data in tables — subject-based lists of rows and 
columns. For instance, you might create a Contacts table to store a list of names, addresses and 
telephone numbers, or a Products table to store information about products. You should always 
start the design of a database by first creating its tables — even before you create any other 
database objects. 

This article explains how to create tables. You will learn how to create a table, add fields to the 
table, and set a table's primary key. You will also learn about data types, and how to set field and 
table properties. 

Before you create tables, you should carefully examine your requirements and plan your database 
to discover what tables you need. For an introduction to planning and designing a database, see 
the article Database design basics. 
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What is a table? 
A table contains data about a particular subject, such as employees or products. Each record in a 
table contains information about one item, such as a particular employee. A record is made up of 
fields, such as name, address and telephone number. A record is also commonly called a row, and 
a field is also commonly called a column. 
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Record or row 

Field or column 

Your database can contain many tables, each storing information about a different subject. Each 
table can contain many fields of different types, including text, numbers, dates, and pictures. 

The following list shows some common examples of tables you might create. 

 A customers table that lists your company’s customers and their addresses  

 A catalog of products you sell, including prices and pictures for each item  

 A tasks table that tracks tasks and due dates  

 An inventory of equipment or stock on hand 

You should plan and design your database carefully to ensure its correctness and to avoid having 
to make too many changes later. For information about planning and designing your database, see 
the article Database design basics. 
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Create a new table 

A simple database, such as a contact list, might use only a single table. Many databases, however, 
use several tables. When you create a new database, you create a new file on your computer that 
acts as a container for all of the objects in your database, including your tables. 

You can create a table by creating a new database, by inserting a table into an existing database, 
or by importing or linking to a table from another data source — such as a Microsoft Office Excel 
2007 workbook, a Microsoft Office Word 2007 document, a text file, or another database. When 
you create a new blank database, a new empty table is automatically inserted for you. You can 
then enter data to start defining your fields. 

Create a new table in a new database 

1. Click the Microsoft Office Button , and then click New.  

2. In the File Name box, type a file name. To change the location, click the folder icon to 
browse.  
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3. Click Create.  

The new database is opened, and a new table named Table1 is created and opened in 
Datasheet view. 

Create a new table in an existing database 

1. Click the Microsoft Office Button , and then click Open.  

2. In the Open dialog box, select and open the database.  

3. On the Create tab, in the Tables group, click Table.  

 

A new table is inserted in the database and the table is opened in Datasheet view. 
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Create a table based on a table template 

To create a Contacts, Tasks, Issues, Events or Assets table, you might want to start with the table 
templates for these subjects that come with Office Access 2007. The table templates were 
designed to be compatible with the Microsoft Windows SharePoint Services 3.0 lists of the same 
name. 

1. Click the Microsoft Office Button , and then click Open.  

2. In the Open dialog box, select and open the database.  

3. On the Create tab, in the Tables group, click Table Templates and then select one of 
the available templates from the list.  

 

A new table is inserted, based on the table template you chose. 
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Import or link to create a table 

ms-help://MS.MSACCESS.12.1033/MSACCESS/content/HA01224251.htm#backtotop
ms-help://MS.MSACCESS.12.1033/MSACCESS/content/HA01224251.htm#backtotop


You can create a table by importing or linking to information stored elsewhere. For instance, you 
can import or link to information in an Excel worksheet, SharePoint list, an XML file, another 
Access database, a Microsoft Office Outlook 2007 folder, and a number of other sources. When 
you import the information, you create a copy of the information in a new table in the current 
database. Conversely, when you link to the information, you create a linked table in the current 
database that represents a live link to the existing information that is stored elsewhere. Thus, when 
you change data in the linked table, you also change it in the original source too (with some 
exceptions — see the note below). When information is changed in the original source by using 
another program, that change is visible in the linked table. 

 NOTE    In some cases, you cannot make changes to your data source through a linked table, 

most notably when the data source is an Excel worksheet. 

Create a new table by importing or linking to external data 

1. To use an existing database, on the File menu, click Open.  

2. In the Open dialog box, select and open the database.  

3. To create a new database, on the File menu, click New.  

 In the File Name text box, type a file name. To change the location, click the 
folder icon.  

 Click Create.  

The new database is opened, and a new table named Table1 is created and opened in 
Datasheet view. 

4. On the External Data tab, in the Import group, click one of the available data sources.  

 

5. Follow the instructions in the dialog boxes.  

Access creates the new table and displays it in the Navigation Pane. 

 NOTE    You can also import or link to a SharePoint list by using a command on the Create tab. 

See the following section for detailed instructions. 
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Create a table based on a SharePoint list 
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You can create a table in your database that imports from or links to a SharePoint list. The list can 
pre-existing, in which case you can import or link to it, or you can create a new custom list or a new 
list that is based on a predefined template. The predefined templates in Office Access 2007 
include Contacts, Tasks, Issues and Events. 

First, open the database in which you want to create the table. 

1. Click the Microsoft Office Button , and then click Open.  

2. In the Open dialog box, select and open the database.  

3. On the Create tab, in the Tables group, click SharePoint Lists.  

 

Then, do one of the following: 

Create the list based on a template 

1. Click either Contacts, Tasks, Issues, or Events.  

2. In the Create New List dialog box, type the URL for the SharePoint site where you want 
the list to reside. Also, enter the name of the new SharePoint list and its description.  

3. If you want the linked table to open after it is created, select the Open the list when 
finished check box (it is selected by default). Otherwise, clear the check box.  

4. Click OK. 

Create a new custom list 

1. Click Custom.  

2. In the Create New List dialog box, type the URL for the SharePoint site where you want 
the list to reside. Also, type the name of the new SharePoint list and its description.  

3. If you want the linked table to open after it is created, select the Open the list when 
finished check box (it is selected by default). Otherwise, clear the check box.  

4. Click OK. 

Import the data from an existing list 

1. Click Existing SharePoint List.  

2. In the Get External Data dialog box, type the URL for the SharePoint site that contains 
the list.  



3. Click Import the source data into a new table in the current database.  

4. Click Next.  

5. Select a check box next to any SharePoint lists you want to import.  

6. Click OK. 

Link to an existing list 

1. Click Existing SharePoint List.  

2. In the Get External Data dialog box, type the URL for the SharePoint site that contains 
the list.  

3. Click Link to the data source by creating a linked table.  

4. Click Next.  

5. Select a check box next to any SharePoint lists to which you want to link.  

6. Click OK. 
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Add fields to a table in Datasheet view 
You store the information items you want to track in fields (also called columns). For example, in a 
Contacts table you might create fields for LastName, FirstName, Telephone Number and Address, 
among others. For a Products table you might create Product Name, Product ID and Price. 

It is important that you choose fields carefully. For example, it's usually a bad idea to create a field 
to store a calculated value. You can usually have Office Access 2007 calculate the value when 
needed instead. When choosing fields, try to store information in its smallest useful parts. For 
instance, instead of a FullName, consider storing a LastName and a FirstName. Generally 
speaking, if you need to report, sort, search or calculate on an item of information, put it in a 
column by itself. For more information about designing a database and choosing fields, see the 
article Database design basics. 

A field has certain defining characteristics. For example, every field has a Name that uniquely 
identifies the field within a table. A field also has a data type that's chosen to match the information 
to be stored. The data type determines the values that can be stored and the operations that can 
be performed, as well as how much storage space to set aside for each value. Every field also has 
an associated group of settings called properties that define the appearance or behavior 
characteristics of the field. For example, the Format property defines a field's display layout — that 
is, how it should appear when displayed. 

When you create a new table, the table opens in Datasheet view. You can immediately add a field 
by typing some information in the Add New Field column. 
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Add a new field to an existing table 

1. Click the Microsoft Office Button , and then click Open.  

2. In Open dialog box, select and open the database.  

3. In the Navigation Pane, double-click one of the available tables to open it.  

4. Type your data in the cell below the Add New Field column header. 

Add a new field to a new table 

1. Click the Microsoft Office Button , and then click Open.  

2. In Open dialog box, select and open the database.  

3. On the Create tab, in the Tables group, click Table.  

 

Access inserts a new table in the database and opens it in Datasheet view. 

4. Type your data in the cell below the Add New Field column header. 

When you enter data in the new column, Office Access 2007 uses the information you type to 
recognize the appropriate data type for the field. For example, if you type a date in the column, 
such as 1/1/2006, Office Access 2007 sees the information you entered, recognizes it as a date, 
and sets the data type for the field to Date/Time. If Access doesn't have enough information from 
what you enter to guess the data type, the data type is set to Text. 

The following table shows how automatic data type detection works in Datasheet view. 

 

If you type: 
Office Access 2007 creates a field with a 
data type of: 

John Text 



http://www.contoso.com  

You can use any valid Internet 
protocol prefix. For example, http://, 
https://, and mailto: are valid prefixes. 

Hyperlink 

50000 Number, Long Integer 

50,000 Number, Long Integer 

50,000.99 Number, Double 

50000.389 Number, Double 

12/31/2006  

The date and time formats recognized 
are those of your user locale. 

Date/Time 

December 31, 2006 Date/Time 

10:50:23 Date/Time 

10:50 am Date/Time 

17:50 Date/Time 

$12.50  

The currency symbol recognized is 
that of your user locale. 

Currency 

21.75 Number, Double 

123.00% Number, Double 

3.46E+03 Number, Double 

 

In addition to determining the data type, Office Access 2007 may set the Format property, 
depending on what you enter. For example, if you type 10:50 am, Access sets the data type 
Date/Time and the Format property to Medium Time. 

If you want to explicitly set the data type and format for a field, overriding the choice that Office 
Access 2007 makes, you can do so by using the commands in the Data Type & Formatting group 
on the Datasheet tab. 

Explicitly set the data type 



1. On the Datasheet tab, in the Data Type & Formatting group, click Data Type.  

 

2. Click the data type you want. 

Explicitly set the format 

1. On the Datasheet tab, in the Data Type & Formatting group, click Format.  

2. Click the format you want. 

When you add a field by typing information into the cell below the Add New Field header, Office 
Access 2007 automatically assigns a name to the field. These names start with Field1 for the first 
field, Field2 for the second field, and so on. It is a good practice to use more descriptive field 
names. You can rename the field by right-clicking its header, and then clicking Rename Column 
on the shortcut menu. 

Field names can consist of up to 64 characters (letters or numbers), including spaces. You should 
try to give fields descriptive names so that you can easily identify them when you view or edit 
records. For example, you might use field names such as Last Name, Address, and Home Phone. 
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Add fields by using field templates 
Sometimes it is easier to choose from a predefined list of fields than to manually create a field. You 
can use the Field Templates task pane to choose from a list of predefined fields. Office Access 
2007 comes with a set of built-in field templates that can save you considerable time when you 
create fields. To create a new field using a field template, you display the Field Templates pane, 
and then drag and drop one or more templates to the table that is opened in Datasheet view. 

A field template is a predefined set of characteristics and properties that describes a field. The field 
template definition includes a field name, a data type, a setting for the field's format property, and 
also a number of other field properties that, when taken together, form a model that serves as the 
basis for creating a new field.  

1. Ensure that your table is in Datasheet view.  

2. On the Datasheet tab, in the Fields & Columns group, click New Field.  
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The Field Templates pane appears. 

3. Select one or more fields in the Field Templates pane and drag them to the table. 
When the insertion line appears, drop the fields in position.  

The fields appear in the datasheet. 

Field templates are models. They provide a basis from which you can create a new field. But it is 
not the only basis from which you can create a new field. In addition to creating a new field from a 
field template, you can also create a new field from an existing field in another table. 
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Add a field from an existing table 
If you are using a database that contains multiple tables, you can add a field from another table. In 
fact, chances are good that some of those tables are related. In a relational database, you store 
information in separate subject-based tables, and then define relationships to provide your 
database management system with what it needs to bring the information together as needed. 
Office Access 2007 allows you to create a new field by adding it from another related table, or by 
adding it from another table for which you have not created a relationship. You add the field by 
using the Field List, which shows you fields available in other tables in your database. 
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Open the Field List pane 

1. Click the Microsoft Office Button , and then click Open.  

2. In the Open dialog box, select and open the database.  

3. In the Navigation Pane, double-click the table in which you want to add an existing field.  

The table opens in Datasheet view. 

4. On the Datasheet tab, in the Fields & Columns group, click Add Existing Fields.  

 

The Field List pane appears. 



The Field List pane lists all of the other tables in your database, grouped into categories. When 
you work with a table in Datasheet view, two categories appear in the Field List pane: Fields 
available in related tables, and Fields available in other tables. The first category lists all of the 
tables with which the table you have open has a relationship. The second category lists all of the 
tables with which your table does not have a relationship. 

For more information about table relationships, see the article Create, edit or delete a relationship. 

When you click the plus sign (+) next to a table to, you see a list of all of the fields available in that 
table. To add a field to your table, drag and drop the field you want from the Field List pane to the 
table in Datasheet view. 

Add a field from the Field List pane 

1. Click the Microsoft Office Button , and then click Open.  

2. In the Open dialog box, select and open the database.  

3. In the Navigation Pane, double-click the table in which you want to add an existing field.  

The table opens in Datasheet view. 

4. On the Datasheet tab, in the Fields & Columns group, click Add Existing Fields.  

 

The Field List pane appears. 

5. Click the plus sign (+) next to a table to display the list of fields in that table.  

6. Drag the field you want from the Field List pane to the table in Datasheet view.  

7. When the insertion line appears, drop the field in position.  

 

The Lookup Wizard starts. 

8. Follow the instruction to complete the wizard.  

After you have completed the wizard, the field appears in the table in Datasheet view. 
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 NOTE    When you drag and drop a field from an unrelated table and then complete the Lookup 

Wizard, a new one-to-many relationship is automatically created between the table in the Field 
List pane and the table you have open. 
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Set a field's data type in Datasheet view 

Office Access 2007 does a good job of automatically detecting the data type for a field that you 
create in Datasheet view. Sometimes, however, you will need to override the decision that Access 
makes. For example, you might have existing products IDs that serve to identify the products you 
sell. If you type a numeric ID, such as 1003, into a table in Datasheet view, the automatic data type 
detection feature sets a numeric data type for the field. However, you should only use a numeric 
data type for fields that will be involved in arithmetic calculations. Normally, identifiers such as a 
product ID should be stored as the Text data type. 

If you want to explicitly set the data type and format for a field, overriding the choice that Office 
Access 2007 makes, you can do so by using the commands in the Data Type & Formatting group 
on the Data tab. 

Explicitly set the data type 

1. On the Datasheet tab, in the Data Type & Formatting group, click Data Type.  

 

2. Click the data type you want. 

Use the following table to determine the correct data type. 

Explicitly set the format 

1. On the Datasheet tab, in the Data Type & Formatting group, click Format.  

2. Click the format you want. 

The following table describes the data types available for fields in Office Access 2007. 

 

Data type Stores Size 

Text Alphanumeric characters  

Use for text, or text and numbers that 
are not used in calculations (for example, 

Up to 255 characters. 
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a product ID). 

Memo Alphanumeric characters (longer than 
255 characters in length) or text with rich 
text formatting.  

Use for text greater than 255 characters 
in length, or for text that uses rich text 
formatting. Notes, lengthy descriptions, 
and paragraphs with formatting such as 
bold or italics are good examples of 
where you would use a Memo field. 

Up to 1 gigabyte of 
characters, or 2 gigabytes of 
storage (2 bytes per 
character), of which you can 
display 65,535 characters in 
a control. 

Number Numeric values (integers or fractional 
values).  

Use for storing numbers to be used in 
calculations, except for monetary values 
(use the Currency for data type for 
monetary values). 

1, 2, 4, or 8 bytes, or 16 
bytes when used for 
replication ID. 

Date/Time Dates and times.  

Use for storing date/time values. Note 
that each value stored includes both a 
date component and a time component.  

8 bytes. 

Currency Monetary values.  

Use for storing monetary values 
(currency). 

8 bytes. 

AutoNumber A unique numeric value that Office 
Access 2007 automatically inserts when a 
record is added.  

Use for generating unique values that 
can be used as a primary key. Note that 
AutoNumber fields can be incremented 
sequentially, by a specified increment, or 
chosen randomly. 

4 bytes or 16 bytes when 
used for replication ID. 

Yes/No Boolean values.  

Use for True/False fields that can hold 

1 bit (8 bits = 1 byte). 



one of two possible values: Yes/No or 
True/False, for example. 

OLE Object OLE objects or other binary data.  

Use for storing OLE objects from other 
Microsoft Windows applications. 

Up to 1 gigabyte.  

Attachment Pictures, Images, Binary files, Office files.  

This is the preferred data type for storing 
digital images and any type of binary file. 

For compressed 
attachments, 2 gigabytes. 
For uncompressed 
attachments, approximately 
700k, depending on the 
degree to which the 
attachment can be 
compressed.  

Hyperlink Hyperlinks.  

Use for storing hyperlinks to provide 
single-click access to Web pages through 
a URL (Uniform Resource Locator) or files 
through a name in UNC (universal 
naming convention) format. You can also 
link to Access objects stored in a 
database. 

Up to 1 gigabyte of 
characters, or 2 gigabytes of 
storage (2 bytes per 
character), of which you can 
display 65,535 characters in 
a control. 

Lookup Wizard Not actually a data type; instead, this 
invokes the Lookup Wizard.  

Use to start the Lookup Wizard so you 
can create a field that uses a combo box 
to look up a value in another table, query 
or list of values. 

Table or query based: The 
size of the bound column.  

Value based: The size of the 
Text field used to store the 
value. 

 

TIP  For phone numbers, part numbers, and other numbers you don’t intend to use for 

mathematical calculations, you should select the Text data type, not the Number data type.  

For the Text and Number data types, you can specify the field size or data type more specifically 
by setting a value in the FieldSize property box. 
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Save a table 
After you add fields to a table, you should save its design. When you save a new table for the first 
time, give it a name that describes the information it contains. You can use up to 64 characters 
(letters or numbers), including spaces. For example, you might name a table Customers, Parts 
Inventory, or Products.  

1. Click the Microsoft Office Button , and then click Save.  

-or- 

Right-click the table's document tab, and then click Save on the shortcut menu. 

-or- 

Click Save on the Quick Access Toolbar. 

2. If you are saving the table for the first time, type a name for the table, and then click OK. 
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Set the primary key 
The primary key of a table consists of one or more fields that uniquely identify each row you store 
in the table. Often, there is a unique identification number, such as an ID number, a serial number, 
or a code, that serves as a primary key. For example, you might have a Customers table where 
each customer has a unique customer ID number. The customer ID field is the primary key of the 
table. 

A good candidate for the primary key has several characteristics. First, it uniquely identifies each 
row. Second, it is never empty or null — there is always a value. Third, it rarely (ideally never) 
changes. Access uses primary key fields to quickly bring together data from multiple tables. 

You should always specify a primary key for a table. Access automatically creates an index for the 
primary key, which helps speed up queries and other operations. Access also ensures that every 
record has a value in the primary key field, and that it is always unique. 

When you create a new table in Datasheet view, Access automatically creates a primary key for 
you and assigns it a field name of ID and the AutoNumber data type. The field is hidden in 
Datasheet view, but you can see it if you switch to Design view. 

Switch to Design View 

1. Right click the document tab, and then click Design View.  

- or - 
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Right-click the table name in the Navigation Pane, and then click Design View. 

- or - 

Click Design View in the Access status bar. 

To change or remove the primary key, or to set the primary key for a table that doesn't already 
have one, you must use Design view. 

Set or change the primary key 

1. Open the table in Design view.  

2. Select the field or fields you want to use as the primary key.  

To select one field, click the row selector for the field you want. 

To select more than one field, hold down the CTRL key and then click the row selector for 
each field. 

3. On the Design tab, in the Tools group, click Primary Key.  

 

A key indicator is added to the left of the field or fields that you specify as the primary key. 

Remove the primary key 

1. Open the table in Design view.  

2. Click the row selector for the current primary key.  

If the primary key consists of a single field, click the row selector for that field. 

If the primary key consists of multiple fields, click the row selector for any field in the 
primary key. 

3. On the Design tab, in the Tools group, click Primary Key.  

 

The key indicator is removed from the field or fields you previously specified as the primary 
key. 



 NOTE    When you save a new table without setting a primary key, Access prompts you to create 

one. If you choose Yes, Access creates an ID field that uses the AutoNumber data type to provide 
a unique value for each record. If your table already includes a AutoNumber field, Access uses it 
as the primary key. 
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Set field properties 
You can control the appearance of information, prevent incorrect entries, specify default values, 
speed up searching and sorting, and control other appearance or behavior characteristics by 
setting field properties. For example, you can format numbers to make them easier to read, or you 
can define a validation rule that must be satisfied for information to be entered in a field. 

The data type of the field determines the properties you can set. For example, the AppendOnly 
property applies only to a field that is set to the Memo data type. You cannot set this property on a 
field with any other data type. 

Access uses the field property settings when you view and edit data. For example, the Format, 
InputMask, and Caption properties affect how your information appears in table and query 
datasheets. In addition, any controls on new forms and reports that are based on the fields in the 
table inherit these same property settings by default. You use other properties to set a default 
value for a field or to require a user to enter a value, which Access enforces whenever you add or 
edit data in the table. 

Set a field property for a table in Datasheet view 

1. Open the table in Datasheet view.  

2. Click in the field for which you want to set the property.  

3. On the Datasheet tab, in the Data Type & Formatting group, select one of the following 
commands:  

 

4.  

 Unique — Sets the Indexed property.  

 Is Required — Toggles the setting of the Required property. If it was set to 
Yes, it is set to No. If it was set to No, it is set to Yes.  

You can set only a few of the available field properties in Datasheet view. To set 
additional field properties, you must open the table in Design view. 
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To have access to and set the complete list of field properties, you must use Design view. 

Set a field property for a table in Design view 

1. Open the table in Design view.  

2. In the upper portion of the table design grid, click the field for which you want to set 
properties (or move to the field by using the arrow keys).  

3. Access displays the properties for this field in the lower portion of the table design grid. 
The data type of the field determines the properties you can set.  

4. In the lower portion of the window, under Field Properties, click the box for the field 
property you want to set. Alternatively, you can press F6 and then move to the property by 
using the arrow keys.  

5. Type a setting for the property or, if an arrow appears at the right side of the property 
box, click the arrow to choose from a list of settings for the property.  

The following table lists the available field properties. 

 

Use this field  
property To 

FieldSize Set the maximum size for data stored as a Text, Number, or 
AutoNumber data type. 

Format Customize the way the field appears when displayed or 
printed. 

DecimalPlaces Specify the number of decimal places to use when displaying 
numbers. 

NewValues Set whether an AutoNumber field is incremented or assigned a 
random value. 

InputMask Display editing characters to guide data entry. 

Caption Set the text displayed by default in labels for forms, reports, 
and queries.  

DefaultValue Automatically assign a default value to a field when new 
records are added. 

ValidationRule Supply an expression that must be true whenever you add or 
change the value in this field. 

ValidationText Enter text that appears when a value violates the 
ValidationRule expression. 



Required Require that data be entered in a field. 

AllowZeroLength Allow entry (by setting to Yes) of a zero-length string ("") in a 
Text or Memo field. 

Indexed Speed up access to data in this field by creating and using an 
index. 

UnicodeCompression Compress text stored in this field when a large amount of text 
is stored (> 4,096 characters) 

IMEMode Control conversion of characters in an Asian version of 
Windows. 

IMESentenceMode Control conversion of characters in an Asian version of 
Windows. 

SmartTags Attach a smart tag to this field.  

AppendOnly Allow versioning (by setting to Yes) of a Memo field.  

TextFormat Choose Rich Text to store text as HTML and allow rich 
formatting. Choose Plain Text to store only text. 

TextAlign Specify the default alignment of text within a control. 

Precision Specify the total number of digits allowed, including those 
both to the right and the left of the decimal point. 

Scale Specify the maximum number of digits that can be stored to 
the right of the decimal separator.  

 

If you want more space to enter or edit a property setting in the property box, press 
SHIFT+F2 to display the Zoom box. If you are entering an input mask or validation 

expression and would like help in building it, click next to the property box to display 
the appropriate builder. 

6. To save your changes, click Save on the Quick Access Toolbar.  

-or- 

Right-click the table's document tab, and then click Save on the shortcut menu. 

-or- 

Click the Microsoft Office Button , and then click Save. 



The following table provides additional information about the FieldSize, Format and New Values 
field properties. 

 

FieldSize 
property Description 

Text Enter a value from 1 to 255. Text fields can range from 1 to 
255 characters. For larger text fields, use the Memo data 
type.  

Number Select one of the following:  

 Byte — For numeric values that range from 0 to 255. 
Storage requirement is a single byte.  

 Integer — For numeric values that range from -
32,768 to +32,768. Storage requirement is two bytes.  

 Long Integer — For numeric values that range from 
-2,147,483,648 to +2,147,483,647. Storage requirement 
is four bytes.  

TIP  Use Long Integer for storing as a foreign key the 

value that appears in another table's primary key 
AutoNumber field. 

 Single — For numeric floating point values that 
range from -3.4 x 1038 to +3.4 x 1038 and up to seven 
significant digits. Storage requirement is four bytes.  

 Double — For numeric floating point values that 
range from -1.797 x 10308 to +1.797 x 10308 and up to 
fifteen significant digits. Storage requirement is eight 
bytes.  

 Replication ID — For storing a globally unique 
identifier required for replication. Storage requirement is 
sixteen bytes. Note that replication is not supported 
using the .accdb file format.  

 Decimal — For numeric values that range from -
9.999... x 1027 to +9.999... x 1027. Storage requirement 
is twelve bytes. 

AutoNumber Select one of the following:  

 Long Integer — For unique, numeric values that 



range from 1 to +2,147,483,648 when the New Values 
field property is set to Increment, and -2,147,483,648 to 
+2,147,483,647 when the New Values field property is 
set to Random. Storage requirement is four bytes.  

 Replication ID — For storing a globally unique 
identifier required for replication. Storage requirement is 
sixteen bytes. Note that replication is not supported 
using the .accdb file format. 

Format 
property 

 
Text You can define a custom format. For more information, see 

Format data in tables, forms, and reports. 

Number Select one of the following:  

 General Number — Displays the number as entered.  

For example, 3456.789 becomes 3456.789 

 Currency — Displays the number using the thousand 
separator, and applies the settings in the Regional and 
Language Options in the Control Panel for negative 
amounts, decimal and currency symbols, and decimal 
places.  

For example, 3456.789 becomes $3,456.79 

 Euro — Displays the number using the Euro currency 
symbol, regardless of the symbol specified in the 
Regional and Language Options.  

 Fixed — Displays at least one digit and applies the 
settings in the Regional and Language Options in the 
Control Panel for negative amounts, decimal and 
currency symbols, and decimal places.  

For example, 3456.789 becomes 3456.79 

 Standard — Displays the number using the thousand 
separator and applies the settings in the Regional and 
Language Options in the Control Panel for negative 
amounts, decimal symbols, and decimal places. This 
format does not display a currency symbol.  
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For example, 3456.789 becomes 3,456.79 

 Percent — Multiplies the value by 100 and displays 
the number with a percent sign added to the end. 
Applies the settings in the Regional and Language 
Options in the Control Panel for negative amounts, 
decimal symbols, and decimal places.  

For example, 0.3456 becomes 35% 

 Scientific — Displays the value in standard scientific 
notation.  

For example, 3456.789 becomes 3.46E+03 

Date/Time Select one of the following predefined display formats:  

 General Date — Displays the value using a 
combination of the Short Date and Long Time settings.  

 Long Date — Displays the value using the Long Date 
setting from the Regional and Language Options settings 
in the Control Panel.  

 Medium Date — Displays the value using the format 
dd-mmm-yy (14-Jul-06, for example).  

 Short Date — Displays the value using the Short 
Date setting from the Regional and Language Options in 
the Control Panel.  

 Long Time — Displays the value using the Time 
setting in the Regional and Language Options in the 
Control Panel.  

 Medium Time — Displays the value using the format 
HH:MM PM where HH is the hour, MM is the minute, and 
PM is either AM or PM. The hour can range from 1 to 12. 
The minute can range from 0 to 59.  

 Short Time — Displays the value using the format 
HH:MM where HH is the hour and MM is the minute. The 
hour can range from 0 to 23 and the minute from 0 to 
59. 

Yes/No Select one of the following:  

 True/False — Displays the value as either True or 



False.  

 Yes/No — Displays the value as either Yes or No.  

 On/Off — Displays the value as either On or Off. 

 NOTE    In the above, On, True and Yes are equivalent. 

False, No and Off are also equivalent. 

New Values 
property 

 
AutoNumber Select one of the following (for the AutoNumber data type 

only):  

 Increment — Start value at 1 and increment by 1 for 
each new record.  

 Random — Start with a random value and assign a 
random value to each new record. 
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Set table properties 
In addition to field properties, you can set properties that apply to an entire table and to entire 
records. You set these properties in the table’s property sheet.  

Set a table property 

1. Open the table in Design view.  

2. On the Design tab, in the Tools group, click Property Sheet.  

 

The table's property sheet is displayed. 

3. Click the box for the property you want to set.  

4. Type a setting for the property.  
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The following table lists the available table properties. 

Use this table property To 

Description Provide a description of the table. 

DefaultView Set Datasheet, PivotTable, or PivotChart as the default view 
when you open the table. 

ValidationRule Supply an expression that must be true whenever you add a 
record or change a record. 

ValidationText Enter text that appears when a record violates the 
ValidationRule expression. 

Filter Define criteria to display only matching rows in Datasheet 
view. 

OrderBy Select one or more fields to specify the default sort order of 
rows in Datasheet view. 

SubdatasheetName Specify whether a subdatasheet should appear in Datasheet 
view, and if so, which table or query should supply the rows in 
the subdatasheet. 

LinkChildFields List the fields in the table or query used for the subdatasheet 
that match this table's primary key field(s).  

LinkMasterFields List the primary key field(s) in this table that match the child 
fields for the subdatasheet. 

SubdatasheetHeight Specify whether to expand to show all available subdatasheet 
rows (the default) when opened, or set the height of the 
subdatasheet window to show when opened. 

SubdatasheetExpanded Set whether to expand all subdatasheets when you open the 
table. 

Orientation Set the view orientation, according to whether your language 
is read left-to-right, or right-to-left. 

DisplayViewsOnSharePoint Specify whether forms and reports associated with this table 
should be available on the View menu in Windows SharePoint 
Services if the database is published to a SharePoint site. 

FilterOnLoad Automatically apply the filter criteria in the Filter property (by 
setting to Yes) when the table is opened in Datasheet view. 

OrderByOnLoad Automatically apply the sort criteria in the OrderBy property 
(by setting to Yes) when the table is opened in Datasheet 



view. 

If you want more space to enter or edit a setting in the property box, press SHIFT+F2 to 
display the Zoom box. If you are setting the ValidationRule property to an expression and 

would like help in building it, click next to the ValidationRule property box to display the 
Expression Builder. 

5. To save your changes, click Save on the Quick Access Toolbar.  

-or- 

Right-click the table's document tab, then click Save on the shortcut menu. 

-or- 

Click the Microsoft Office Button , and then click Save. 
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See Also 

 Database design basics 
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